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Getting Started in AutoCare

AutoCare stores maintenance and repair histories for all your vehicles.    It will remind 
you when a maintenance task is due.      It will print reports that describe all the work 
performed on your car.      In addition, AutoCare    contains a complete car repair and 
maintenance reference.    Consult    AutoCare for step by step instructions on many common 
maintenance tasks.    Each instruction set can be printed so it is easily available while you 
work.      Trouble shooting charts are also included to help you quickly zero in on the cause    
of many common vehicle problems.

Follow these steps to tailor the program to your needs:      

Set up your phone book with names, addresses and phone numbers of all dealerships
and repair shops you use.

Establish a schedule for your vehicle's maintenance.    Oil changes, coolant checks, or
any other task performed on your vehicle should be entered into the schedule.      Remember 
that the schedule defines only how often each task should be done.      The actual 
maintenance performed on your vehicle is recorded in the maintenance log,    not the 
schedule.      An example schedule is provided that you can modify to fit your vehicle(s).

Set up the four buttons on the far left side of the toolbar.      Each button can display a
vehicle and/or label of your choice.    The buttons are used to quickly retrieve information on 
each of your vehicles.      The buttons can also be used to start computer programs of your 
choice.      If you own fewer than four vehicles, you might want to use one of the buttons to 
start your home accounting program.        You can also leave any of the buttons blank. 

How To Set Up The Buttons:

Adding a new vehicle - Click on any blank button to open a new    General dialog view .      
Click on the image button at the top right of the screen.    The Vehicle dialog box will be 
displayed.    Enter a label for your button and select the icon you want displayed.      Press OK 
to exit the dialog box, then press Save to update the button.

You can add new vehicles even after all four buttons are filled: Select 'New' from the drop 
down 'File' menu.    Select your icon and label as described above.      Then follow the 
instructions below to add the new vehicle to an existing button. 

Change a vehicle button - To associate a different vehicle with a button, or to make a 
button start a program,    select    Button Setup from the drop down Service menu.      Indicate 
the button you want to configure on the Setup dialog box,    then select the program or 
vehicle you want the button to access.    To make the button blank, click the 'Clear' button in 
the setup dialog.    Press the OK button to save the changes.



File menu commands

The File menu offers the following commands:

New Creates a new vehicle history.
Open Opens an existing vehicle history.
Save Saves the active vehicle history using the same file name.
Save As Saves the active vehicle history to a specified file name.
Print Prints the active vehicle history.
Print 
Preview

Displays the vehicle history on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
1,2,3,4 Displays the last four vehicle histories you viewed.
Exit Exits AutoCare.



Advisor menu commands

The Advisor is your maintenance and repair reference.      It includes a trouble shooting 
section,    tips on buying a used car, an extensive glossary, and other information on 
maintaining and repairing your vehicle.    The menu offers the following commands:

Contents View the Table of Contents in AutoCare advisor.
Selection View the Car Selection/Trouble Shooting picture.    
Previous Takes you to the last viewed section in    AutoCare advisor.

Service menu commands

The Service menu offers commands that enable you to tailor AutoCare to suit your needs.

Schedule Opens the Scheduled Maintenance 
dialog box.

Phone Book Opens the Phone Book dialog box.
Button Setup Opens the Button Setup dialog box.



View menu commands

The View menu allows you to select the type of information displayed for each of your 
vehicles.    The following commands are available:

General Displays the General dialog view for the selected vehicle.
Maintenance Displays the Maintenance dialog view for the selected 

vehicle.
Repairs Displays the Repairs dialog view for the selected vehicle.
Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.



Help menu commands

The Help menu offers the following commands: 

Index Displays an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new vehicle history in AutoCare.

You can open an existing vehicle history with the Open command.

Shortcuts
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing vehicle history (*.afi).

You can create new vehicle histories with the New command.

Shortcuts
Keys: CTRL+O



File Open dialog box

The following options allows you to specify which file to open:
File Name

Type or select the filename you want to open.    The box lists files with the extension you 
select in the List Files of Type box (*.afi). 

List Files of Type
Select the type of file you want to open:
 example :    *.afi

Drives
Select the drive in which AutoCare files are stored. 

Directories
Select the directory in which AutoCare files are stored.



Save command (File menu)

Use this command to save the active vehicle history to its current name and directory.    
When you save a vehicle history for the first time, AutoCare displays the Save As dialog box 
so you can name your vehicle history.    If you want to change the name and directory of an 
existing vehicle history before you save it, choose the Save As command.

Shortcut
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active vehicle history.    AutoCare displays the Save
As dialog box so you can name your vehicle history.    

To save a vehicle history with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a vehicle history with a different name.    A filename can 
contain up to eight characters and an extension of up to three characters.    AutoCare 
adds the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the vehicle history.

Directories
Select the directory in which you want to store the vehicle history.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
vehicle histories you closed.    Choose the number that corresponds with the document you 
want to open.



Exit command (File menu)

Use this command to end your AutoCare session.    You can also use the Close command on 
the application Control menu, or the exit button on the tool bar.    AutoCare prompts you to 
save vehicle histories with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4
Button: Click on the Exit button located on the toolbar.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in AutoCare.    A check mark appears next to the menu item when 
the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

See also : Button Setup command    This will show you how to change the representation of 
any of the first four buttons.    
The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in AutoCare.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Opens the General dialog view for the selected vehicle.

Opens the Maintenance dialog view for the selected vehicle.

Opens the Repairs dialog view for the selected vehicle.

Opens the Schedule Maintenance dialog box for any vehicle.

Opens the AutoCare advisor reference book.

Opens the Phone Book dialog box.

Opens the help window to the table of contents.

A quick way of exiting the program.



General command (View menu)

Opens the General dialog view for the selected vehicle.

Shortcuts
Button: Click on the General button located on the toolbar.



Vehicle 
Make - Enter the type of vehicle you would like to keep a record on.

e.g.: Honda
Model - Enter the model name of the vehicle.

e.g.: Accord 4dr
VIN - Enter the vehicle identification number for the vehicle.
Year - Enter the year the vehicle was manufactured.
Engine Size - Enter the size of your engine.

e.g.: 4 cyl., 1.6 Liters
Tag Number - Enter the tag or license plate number of your vehicle.



Insurance
Company - Enter the name of your insurance company
Policy # - Enter the policy number.
Expire - Enter the date that the policy will expire on.
Agent - Enter the name of the insurance agent who handles the policy.
Phone - Enter the phone number where your insurance agent can be reached.



Bank Loan
Company - Enter the name of the institute which carries the loan on this vehicle.
Loan # - Enter the account number of the loan.
Phone - Enter the phone number of the institute that has the loan.



Image Button - Selecting the image button will bring up a Vehicle Setup dialog box.    This dialog box 
allows you to select an icon and enter a label for each of the four vehicle buttons.



Vehicle Setup dialog box (Image button)

This dialog box allows you to select an icon and button label for the vehicle.



Vehicle label - Enter a name to represent your vehicle.    This is the name that will appear on the vehicle 
selection button.



Icon File - Select a file containing the icon you wish to use.    VEHICLES.DLL is included with AutoCare 
and contains many images.    You can select icon files of your own or use icon files supplied with 
Windows.    MORICONS.DLL is in your Windows directory and contains additional icons you can use.



Current Icon - Select one of the icons to represent your vehicle.    This is the image that will appear on 
the vehicle selection button.



Button Groupings for Maintenance and Repair views

 Click on the icon you want specific information about.



Maintenance command (View menu)

Opens the Maintenance dialog box for the selected vehicle.

To make changes to a highlighted task, or add new items, click on the Add Button.
To quickly view any task, double click on the desired line.    This brings up the Maintenance Detail dialog 
box allowing you to review the task and make necessary changes.

Shortcuts
Button: Click on the Maint. button located on the toolbar.



This area displays all the maintenance performed on the selected vehicle, or the maintenance that is due. 
The listing can be sorted by date, task, or next maintenance due.



Maintenance Detail dialog box (Add button)

The maintenance Detail dialog box allows you to edit or add tasks to the maintenance list for the vehicle 
that you have selected.



Task - Select the name of the task from the pull down menu.    The task list is created by the Scheduled 
maintenance dialog box.    You can also enter a task that is not in the list by simply typing it in from the 
keyboard.    However, this will not update the scheduled maintenance list, you can only change the list 
from the scheduled maintenance dialog box.
Hint: Double clicking on the pull down menu arrow will keep the current task active and enter in today's 
date.



Performed 
By - This will be pre-filled if the task is listed in the scheduled maintenance section and there is a 

value for the field.    If the task was performed by someone other than the regularly scheduled person you 
can change the name in the box.    This will only change the name for this one occurrence.    To make the 
change permanent refer back to the scheduled maintenance section.

Date - Enter the date that the task was performed on.    The program will automatically put in the 
day of the week.    HINT: If a "/" is entered today's date will be displayed after the Tab key is pressed.

Odometer - Enter the mileage on the odometer at the time the task was performed.



Next Scheduled
Only change the date or mileage in this section to override the predetermined schedule.    If the time or 
mileage intervals need to be changed permanently,    click on the Schedule button and make the changes 
there.

Next Date - The date and day of the week for the next scheduled occurrence for this task. A date 
will appear based on the information entered in the scheduled maintenance log.    You can revise this date
if necessary.

Next Odometer - The mileage for the next scheduled occurrence of this task.    A value will 
appear in this box based on the information entered in the scheduled maintenance log.    You can revise 
this value if necessary.



Notes - Use this field for comments or any other information regarding the task which was performed.



Repairs command (View menu)

To make changes to the highlighted task, or add new items, select the Add button to bring up the Repair 
Detail dialog box.    
To quickly view any task double click on the desired line.    This brings up the Repair Detail dialog box 
allowing you to review the task and make any necessary changes.

Shortcuts
Button: Click on the Repair button located on the toolbar.



This area displays all the repairs that have been made on the selected vehicle.    The repair history can be
sorted by date, or by repair name.



Repair Detail dialog box (Add button)

The Repair Detail dialog box allows you to edit or add tasks to the repair list for the vehicle that has been 
selected.



Repair - Enter a short description of the repair that was made to the vehicle.



Performed 
By - Enter the name of the person or company who did the repair on the vehicle.
Date - Enter the date that the repair was performed.    The program will automatically put in the 

day of the week.    HINT: If a "/" is entered today's date will be displayed after the Tab key is pressed.
Odometer - Enter the mileage on the odometer at the time the repair was performed.



Schedule command (Service menu)

Shortcuts
Button: Click on the Schedule button located on the toolbar.



Task - Enter the name of the scheduled maintenance task you would like performed on a vehicle.
By- Enter the name of the company or person who usually performs the above task.
Notes - An area used to enter any notes you might want to remember about the person, company or task.



This area displays a list of scheduled maintenance items.    The one which is highlighted can either be 
deleted or edited.    To add additional items select the New button.



New Button - Clears the work area so a new item can be entered.



Schedule Every
In the first box enter the number of days, months, or years between task occurrences.    Then make sure 
the corresponding word is showing in the next field.

In the third field enter the number of miles or kilometers between the occurrence of tasks.    Then make 
sure the corresponding word is showing in the next field.



Contents command (Advisor menu)

The contents command will take you directly to the Table of Contents in the AutoCare advisor section.



Selection command (Advisor menu)

The selection command takes you directly to the car selection picture.    The car selection picture can be 
used to quickly go to any repair or maintenance topic.



Previous command (Advisor menu)

The previous command will take you back to the location in the AutoCare advisor where you last were.

Shortcuts
Button: Click on the Advisor button located on the toolbar.



Phone Book command (Service menu)

Shortcuts
Button: Click on the Phone button located on the toolbar.



This area displays the list of companies which are available.    The one which is highlighted can be either 
deleted or edited.    To add additional companies select the New Button.



Phone - Enter the phone number of the repair or service company.
Address - Enter the address of the repair or service company.



Company - Enter the name of a repair or service company.
Contact - Enter the name of the person you deal with at the company.



Comments - Enter the type of work or service the company performs or the name of other 
contacts, etc..



Button Setup command (Service menu)

Gives you the option of changing what each of the four buttons on the far left side of the 
toolbar represents.    Use the Button Setup dialog box to associate a button with any 
previously defined vehicle file or computer program.



SELECT A BUTTON TO CONFIGURE:
Select one of the four dots (each represents one of the buttons on the left of the toolbar) you
would like to setup.



SELECT A VEHICLE OR A PROGRAM: 
The current vehicle or program associated with the selected button will be displayed in the 
field.    If you wish to change the current    file or program choose the clear or select button.
The Clear button allows you to clear the display.    This will make the button blank.
The Select button allows you to locate the desired file by searching the directories.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item.    The right side of the status bar indicates the date and
keyboard latch state.    A check mark appears next to the menu item when the Status Bar is 
displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the AutoCare window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
The current date is also shown on the status bar.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using AutoCare and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.

Shortcuts
Button: Click on the Help button located on the toolbar.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Displays the copyright notice and version number of AutoCare.    Clicking on the AutoCare 
icon will make the sound of an engine starting.



Context Help command 

Use the Context Help command to obtain help on some portion of AutoCare.    Then click 
somewhere in the AutoCare window, such as another Toolbar button.    The Help topic will be 
shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

AutoCare

The title bar is located along the top of a window.    It contains the name of the program.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button

Document Control-menu button

Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the active window.    The scroll boxes inside the 
scroll bars indicate your vertical and horizontal location in the vehicle history document.    
You can use the mouse to scroll to other parts of the vehicle history document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the AutoCare window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a active window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the AutoCare window 



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should 
modify a document using your application.    

If your application supports multiple document types and you want to have a distinct help 
topic for each, then use the help context i.d. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the
first document type supported by your application.    AppWizard produces an alias in the .HPJ 
file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for 
that document type. >>



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Sort By - This section gives several options for sorting the displayed data.    Click on the 
desired manner of sort you want to view.



Save Button - Saves the current changes made in the dialog box.



Add Button - Displays a Maintenance Detail dialog box which allows you to make changes 
or add additional tasks performed on the selected vehicle.



Add Button - Displays a Repair Detail dialog box which allows you to make changes or add 
additional repairs performed on the selected vehicle.



Cancel Button - Closes the active dialog box or window without making any changes.



Delete Button - Deletes the unwanted highlighted item.



Close Button - Closes the current dialog box or window.



Notes Section - Use this area to enter any additional notes or comments you might want to refer to at a 
later time.



Icons - This section displays two icons.    The first represents the dialog box which is opened.
The second represents the vehicle being worked on.    This icon will correspond to the 
selected button.    To change the icon click on the Image button.    When back at the General 
dialog window click on the Save button and the icon will change on the screen.



Help Button -    Opens the help section on the current dialog box.



OK Button - Saves the changes that have been made to the current dialog box.



Browse Button - Opens a browse dialog box, where you can perform a search to locate the 
desired file by its extension.    If a file is selected then it will display the full path for you in 
the dialog box.



Report Button - Opens the Print Preview screen allowing you view the vehicle history prior 
to printing.



Print command (File menu)

Use this command to print a vehicle history.      This command presents a Print dialog box, 
where you may specify the range of pages to be printed, the number of copies, the 
destination printer, and other printer setup options.

Shortcuts
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the vehicle history should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire vehicle history.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active vehicle history as it would appear when printed.    
When you choose this command, the main window will be replaced with a print preview 
window in which one or two pages will be displayed in their printed format.    The print 
preview toolbar offers you options to view either one or two pages at a time; move back and
forth through the vehicle history; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the vehicle history is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.



Page Setup command (File menu)

<< Write application-specific help here. >>



Warranty

Free Lifetime Warranty
Please be sure to send in your registration card.    If your software fails we will replace it 
FREE, if registered.    Sorry, we cannot be responsible for lost data.

Free Technical Support
Only customers who have sent in registration cards are eligible. Before calling, please have 
your computer on and your registration number available.




